
 
Grading in My Sac State 

 

 

 Page 1 
 
 

 
  

 

 

 

 

 
Grading in My Sac State 
 

Assigning and Approving Grades 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact Us 

http://www.csus.edu/atc 

servicedesk@csus.edu 

(916) 278-7337 [IRT Service Desk] 

  



 
Grading in My Sac State 

  

 

Page 2 
 

      
 
 

Department Common Management Systems 

File Name Grading in My Sac State 

Version  

Document Generation Date 10/20/2010 

Date Modified 05/10/2018 

Last Changed by Corrin Mattos 

Status Final 

 
 



 
Grading in My Sac State 

 

 

 Page 3 
 
 

Table of Contents 
 
Grading in My Sac State .............................................................................................................. 4	

Navigating to My Sac State ......................................................................................................... 4	
Faculty Center Overview ............................................................................................................. 6	
Grade Roster Page Overview .................................................................................................... 10	
Assigning Roster Grades ........................................................................................................... 13	
Canvas Grades ........................................................................................................................... 15	
Saving In-Progress Grade Rosters ............................................................................................. 15	
Adding an Incomplete Contract ................................................................................................. 16	
Approving & Submitting Completed Grade Rosters ................................................................. 19	
Viewing Posted Grades ............................................................................................................. 22	
Printing the Grade Roster .......................................................................................................... 23	
Download the Grade Roster to Excel ........................................................................................ 24	

 
 



 
Grading in My Sac State 

  

 

Page 4 
 

      
 
 

Grading in My Sac State 
This manual will show you the process of assigning and approving grades for your 
students in My Sac State. 

Navigating to My Sac State 
 

1. Open a browser window (e.g. Internet Explorer) and navigate to the main 
Sacramento State University home page:  http://www.csus.edu. 

 
2. From the Sacramento State Home page, click on the Log-in button located next 

to the My Sac State logo. The My Sac State guest page appears. 
 

  Note:  You can navigate directly to My Sac State by typing the following 
address in your browser’s address bar:  https://my.csus.edu. 

 
3. In the Log In box, enter your SacLink ID and Password and click the Log In 

button.  
 

 
 
Figure 1:  My Sac State Log In page. 
 
 

 Note:  If you are a new user and have not created a SacLink account or if you 
have forgotten your account information, you can click on the Trouble signing 
in? link located under the Sign in button. After clicking this link you will be taken 
to a page with instructions for creating a SacLink Account and University Help 
Desk contact information.  
 

4. After you sign in, your Home tab displays.  
 

5. Locate and select the Faculty Center link.  
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Figure 2:  Home tab, clicking the Faculty Center link. 
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Faculty Center Overview 
 
On the Faculty Center page you will see: 

• Your name at the top of the page. 
• Your most recent teaching term. 
• Radio buttons that allow you to specify how you want to view your teaching 

schedule:  
o Show all classes 
o Only classes with enrollment 
o View my weekly schedule  

• A Legend showing the different icons you will encounter on your Faculty Center: 

o Class Roster   

o Grade Roster  
• Your Teaching Schedule for the term indicated on the page. 
• My Favorite Websites: Links to websites you have saved. 

 
 

 
 
Figure 3:  Faculty Center page. 
 
 
 
 



 
Grading in My Sac State 

 

 

 Page 7 
 
 

 
1. Verify that the correct Term for which you will be assigning and approving grades 

displays at the top of the page.  
 
If the Term that you want to assign and approve grades for is not the one shown 
at the top of the page, you will need to click on the Change Term button to select 
the correct term. 
 

 
 
Figure 4:  Changing the term on the Select Term page. 
 

2. Click the Change Term button, if necessary. The Select Term page displays. 
  

3. On the Select term page, select the radio button next to the appropriate term.  
 

4. Click on the Continue button. This step will take you back to your Faculty Center 
page.  
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Figure 5:  Faculty Center page for term selected. 
 

5. Verify that the radio button for the “Show all classes” Teaching Schedule view is 
selected. 

 

 
 

6. In the My Teaching Schedule box, you will see all the courses you are teaching 
for the term selected. Next to each of these courses you will see a class roster 

icon and a Grade Roster icon  .  
 

 
Figure 6:  Clicking the Grade Roster Icon for the Class you wish to assign grades. 
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You will also see a Grade Roster Status column with an icon indicating the status of the 
Grade Roster for each class. The possible icons are as follows: 
 
Grade Roster Status Status 

Icon 
If a Grade Roster is not complete  
If a Grade Roster is Approved by the Instructor but not yet posted to the 
Student’s Records  
If a Grade Roster is Approved and Posted to the Student’s Records  
 

7. Click on the Grade Roster icon  next to the class for which you wish to begin 
assigning and approving grades. The Grade Roster page will display.  

 
 

 Note:  You can also access the grade roster for a class through the Class 
Roster page by clicking on the Grade Roster Button at the bottom of that page. 
For this example we will be accessing the Grade Roster through the icon located 
on the “My Teaching Schedule” table of classes as shown here. 
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Grade Roster Page Overview 
Before you begin assigning and approving grades, it is important for you to become 
acquainted with the Grade Roster page. The following provides you with an overview of 
the information, buttons, and fields that you will encounter in this process.  
 

 
Figure 7:  Grade Roster page. 
 
 

1. At the top of the Grade Roster page you will see the Class Number, Course 
Name and Description for the class you selected.  
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Figure 8:  Grade Roster Information box. 
 
 

2. In the Grade Roster Information box you will see detailed information for the 
Course, Description, Class number, Class Section, Component, Institution, Term, 
Session, Career, Meeting Location details and Instructor’s name.  

 
3. The *Grade Roster Type field defaults to “Final Grade”. Leave as is. 

 
4. The *Approval Status field defaults to “Not Reviewed”. You will need to select 

the appropriate status for this field based on the following:  
 

• Not Reviewed:  The field defaults to this status so that you can begin 
assigning grades to your students. The Approval Status must remain in “Not 
Reviewed” status until you are finished editing the Grade Roster. 

 
• Approved:  After you assign grades to your students, and have reviewed the 

grades, select this status to approve the Grade Roster. Setting the status to 
"Approved" indicates that your Grade Roster is ready to be posted by the 
Registrar's Office.  The Registrar's office will run the Grade Posting Process.  

 
• Posted: After you have set your grades to an “Approved” status, the 

Registrar’s Office will finalize the process by posting the grades to the 
students’ academic records. This finalization then allows the students to view 
their grades in My Sac State. You will know that your grades are posted when 
the Approval Status field is grayed-out and “Posted” is displayed next to the 
status. 

 
Please Note:  If you need to change a grade after your Grade Roster has 
been posted, you will need to submit a paper grade change petition to 
the Registrar's Office. 
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5. The < - add this grade to all students field allows you to select a grade from 
the drop down list and assign it to all the students in the course. This feature may 
be useful for Credit/No Credit Courses where most of the students will receive 
the same grade. 

 
6. When selected, the Display Unassigned Roster Grade Only checkbox allows 

you to display only the students’ names for which you have not assigned a grade.  
 

7. The Student Grade table is the area where you will be assigning a Roster Grade 
to each of your students. On this table you will see the following: 

 

 
Figure 9:  Student Grade tab, some grades assigned. 
 
 

• ID field:  Your students' Sac State ID's displays in this field. The Sac State ID 
is a number used to identify students and their records on the campus. 

• Student Name field:  The student’s name will display in the following format 
Last Name, First Name. 

• Roster Grade field:  You will be selecting grades from this drop down menu 
field. The choices available on your menu will be based upon the course 
setup (e.g., classes receiving letter grades vs. credit/no credit classes).  

• Official Grade field:  This field will populate with the Roster Grade you 
assigned and approved in this grading process after the Registrar's Office 
runs the post process to post the grades. 
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• Career: This field displays the student’s career (e.g., Undergraduate, 
Postbaccalaureate). 

 

 
Figure 10:  SacCT Grade Import option. 
 

• SacCT Grade Import: If your course is active in the SacCT system, a 
“SacCT Final Grade Import” option will be displayed above your Student 
Grade table. This option allows you to import grades from your SacCT 
gradebook directly into the official Grade Roster in your Faculty Center. See 
the “Importing Grades from SacCT” section for further detail. 

 
Helpful Tips 
 
Before you begin assigning and approving grades for your students, please keep in mind 
the following tips: 
 

• Don’t skip a student! If you have a large class chances are that only a portion 
of the students will display at a time in the Student Grade table. Use the View All 

link and the “Next” and “Previous” Arrows (< and >)  located at 
the top of the Student Grade table to navigate through all of the students. 

 
• Save your work often! We recommend that you click the green SAVE Button 

 (located at the bottom of the page) after selecting grades for every 
20 students. After clicking the SAVE button you can resume assigning grades.  

 
You are now ready to assign the Roster Grades! 

Assigning Roster Grades 
 

1. On the Grade Roster page, verify that the *Grade Roster Type field displays 
“Final Grade” and that the *Approval Status field displays “Not Reviewed”. 

 
2. Leave the Display Unassigned Roster Grade Only checkbox deselected. 
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3. Scroll down to the Student Grade table which displays all the students in the 
course. If all the students are not displaying at one time in the table, use the 
“Next” and “Previous” arrows to navigate through all students. 

 
4. To assign a grade, click on the Roster Grade drop down field button next to 

the name of the student for which you wish to assign a grade. Select the 
appropriate grade from the drop down list. The grade that you select will appear 
in the Roster Grade field.  

 
5. Use the Roster Grade drop down list field in the row next to each of the 

student’s names to assign a grade to each individual.  
 

6. If you come across a student on the Student Grade table that already has a 
grade assigned by the Registrar’s office, no Roster Grade drop down menu will 
appear and the grade will automatically be posted under the Official Grade 
column. An example of this would be a “W” grade where the student has a 
Withdrawal status.  

 

 
Figure 11:  Student with a grade of “W” withdrawal.  
 

 
7. If you assign a grade of “WU” for an unauthorized withdrawal, you will have the 

option of entering the last date the student attended class. If you do not know the 
last class the student attended, you can leave the default date which is the 
census date. 

 

 
 
Figure 12:  Assigning a “WU” grade.   
 
  

The WU Last Date of Attendance 
field will default to the census date. 
You can change this date to the last 
day the student attended class. 
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Canvas Grades 
 
Pardon our progress! Importing grades from Canvas into the Grade Roster is currently 
unavailable. We appreciate your patience, and offer manual import instructions below. 
 
If you have questions about Canvas, importing grades, or grading in My Sac State 
please contact the Academic Technology Center at academictechcenter@csus.edu, 
(916) 278-2450, or visit www.csus.edu/canvas.  

Saving In-Progress Grade Rosters 
 

1. If you ARE NOT READY to submit your grades for POSTING, leave the 
*Approval Status field as “Not Reviewed” and click the Save button. This will 
allow you to come back to your Grade Roster to make changes or assign new 
grades (as long as you come back before the date that the Registrar’s Office 
runs the Final Posting Process).  

 

 
 
Figure 17:  Saving the Grade Roster. 
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2. If you save a Grade Roster with an *Approval Status of “Not Reviewed”, you will 
receive a pop-up warning message reminding you that the grade roster is not 
complete and that you must change the *Approval Status to “Approved” for the 
grade roster to be posted. 

 
 

 
 
Figure 18:  Warning message “Grade Roster is not complete”. 
 
 

 
3. Click the OK button on the pop-up warning box. You will need to come back and 

change the *Approval Status to Approved when you are ready to submit your 
grades. 

 
4. When you return to a grade roster that is incomplete (still in “Not Reviewed” 

status), you can select the Display Unassigned Roster Grade Only checkbox 
to view records for students who have not been assigned a grade or you can 
simply scroll down the page to see which students have not been assigned a 
grade. 

 

 
  Note:  Selecting this option will only display students who do not have a 

grade assigned. If you want to view both graded and ungraded students again on 
the page you will need to de-select the “Display Unassigned Roster Grade Only” 
checkbox.  

 

Adding an Incomplete Contract 
 

1. If you assign an Incomplete grade (“I”), an Add link will appear in the Incomplete 
Contract column after you save your roster.  
 

2. Select the Add link in the Incomplete Contract column. 
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Figure 19:  Assigning an Incomplete grade.  
	
 
The Incomplete Contract page will display. The only field you are required to complete 
on this page is the Reason Code. 
 

3. Select one of the available Reason Code values. 
	

 Figure 20:  Adding an Incomplete Contract.	
	

• Grade Without Further Work:  If you choose to use the “Grade Without 
Further Work” field please be aware that you will still need to submit a Grade 
Completion form to the Office of the University Registrar to have the student’s 
Incomplete grade converted to the grade he/she earned.  



 
Grading in My Sac State 

  

 

Page 18 
 

      
 
 

• Deadline For Completion:  The “Deadline For Completion” field will default 
to one year later. You can select a different date within that twelve month 
period. 

• Description:  The “Description” field is free-form text and additional rows can 
be added by using the “plus” sign at the end of the row. Please note that the 
student will be able to see what you type in the Description field. 

• Date Accepted By Student:  The “Date Accepted By Student” field is not 
being used at this time. 

	

	
Figure 21:  Incomplete Contract data fields. 
	

4. When you are finished click Apply to save the contract and then OK to return to 
the grade roster. 

	

 
Figure 22:  Finishing and Incomplete Contract. 

This field is not being used. 

This field is optional. 

The date will default to one year later. You can 
change this to any date prior to the default date. 

Warning: The student will see what is typed in the Description box. You 
can add more rows of required work using the plus “+” sign to the right. 

After entering the Incomplete Contract information, use the 
“Apply” feature to save the contract. Use the “OK” feature to 
return to your roster after finishing. 
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Approving & Submitting Completed Grade Rosters 
 

1. When you have assigned grades to all the students, Review all the information 
and make sure you assigned grades correctly.  

 
2. If you are Ready to Submit your grades, change the status in the *Approval 

Status field to “Approved”. All students must have a grade assigned before you 
select the “Approved” status. Notice that the Roster Grade field is no longer a 
drop down field.  

 

 
Figure 23:  Approving the Grade Roster. 
 

Note:  The *Approval Status field will turn Red if you change the status to 
“Approved” and have not assigned grades to all students or have not saved a 
contract for any “I” (incomplete) grades assigned.  
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3. If you receive an error indicating that your Grade Roster is not complete, change 
the Approval Status back to “Not Reviewed” and assign any missing grades 
and/or add any missing contracts for “I” (incomplete) grades before attempting to 
select the “Approved” status again. 

 

 
Figure 24:  Approving an Incomplete Grade Roster; warning error message. 
 

4. Click the Save button at the bottom of the page to complete the approval process 
for the Grade Roster. This will allow the batch process to pick up the grades for 
posting to the students’ records. 

 
 

 
Figure 25:  Saving the Approved Roster and receiving the “successful completion” message. 
 
 

5. After you click the Save button, you will receive a Pop-Up Message which 
indicates that you have successfully completed grading for this class and 
provides you with information about important dates. Click the OK button on the 
pop-up message box to continue. 
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6. Your grades will be automatically posted and available for students to view after 
the Registrar’s Office runs the post process.  

 
7. Click the Return button to go back to your Faculty Center page. Proceed with the 

grading process by selecting the Grade Roster icon  on the next course’s 
row. If you have no other courses for which to assign grades, you can Sign Out.  
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Viewing Posted Grades 
After the Registrar’s Office has run the post process to post grades, you can go back to 
your My Sac State account and view the Posted Grades. 
 

1. Once logged into your My Sac State account, click on the Faculty Center link. 
 
2. Access the correct Teaching Schedule by selecting the appropriate term. 

 
3. In the Teaching Schedule table select the Grade Roster icon for the class you 

wish to view. The Grade Roster page for that class will display. 
 

4. After the grade roster has been posted the *Approval Status field will display as 
“Approved” and be grayed out and the word Posted will appear next to this field. 
The Official Grade column will populate with the final grades and the Status 
column will display the word “Posted”. 

 

 
Figure 26:  Posted Grade Roster. 
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 Note:  Grade Changes after the grade roster has been posted, will require a 
Grade Change petition to be submitted to the Registrar’s office. 

Printing the Grade Roster  
 
If you want to print the Grade Roster, click on the Printer Friendly Version link at the 
bottom of the page. A Printer Friendly Version of your grade roster displays.  
 

 
Figure 27:  Printer Friendly Version Grade Roster. 
 
 

1. Go to the File > Print menu options on the browser window to print the roster.  
 

2. When you are done printing, click the Return link to go back to the Grade Roster 
page. 
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Download the Grade Roster to Excel 
If you wish to save the Grade Roster to your computer for later viewing you have the 
option of downloading the grade roster into Excel. On the Grade Roster page above the 

Student Grade table, you will see a Grid like icon with a red arrow . You will use this 
icon in the downloading process to Excel. Depending on the browser you use, follow 
these instructions. 
 
 

 
Figure 28:  Downloading the Grade Roster to Excel – click grid icon. 
 

Internet Explorer – Download Grade Roster to Excel 
 

1. On your keyboard, hold down the CTRL key and use your mouse to Left Click 

ONCE on the Grid icon   while you continue to hold down the CTRL key. DO 
NOT RELEASE THE CTRL key on your keyboard.  

 

 Note:  If you have pop-up blocker enabled on your browser, you will need to 
disable your pop-up blocker before attempting to download the roster to excel. 
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Figure 29:  Internet Explorer pop-up blocked message. 
 
Example: Using Internet Explorer with a pop-up blocker would generate a message like 
the one pictured above.  

2. If you see this message, right-click the yellow bar and select either the 
Temporarily Allow or Always Allow Pop-ups option. 
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3. As you continue to hold down the CTRL Key on your keyboard, a File Download 
pop-up box will display asking you to Open or Save the grade roster. You can 
release the CRTL key after you make a selection to Open or Save the grade 
roster. 

 

 
 
Figure 30:  Internet Explorer File Download pop-up box. 
 

4. On the File Download pop-up box, click the Open button to open the grade 
roster within the browser which will display the roster in grid format. 

 
OR 

  
5. If you choose to Save the roster, click the Save button to save the excel version 

of the roster to your computer.  
 

a. If you choose to Save the file you will get a Save As pop-up box. Specify 
the location where you want to save the file.  

 
b. Once the grade roster has been successfully downloaded you will receive 

the Download Complete pop-up box. Click the Open button to 
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automatically open the excel file or click the Open Folder button to go to 
the location where you saved the file.  

 

Mozilla Fire Fox – Download Roster to Excel 
 

1. Begin by disabling the pop-up blocker option on your browser.  To disable pop-up 
blocker go to your browser’s Tools Menu > Select “Options” > Select “Content” 
and un-check the “Block pop-up windows” checkbox. Click the OK button on the 
Options window to save changes 

 

 
 

Figure 31:  Disabling pop-up windows blocker on Mozilla Firefox. 
 

2. Back on the Grade Roster page Left Click ONCE on the Grid icon  located 
above the Student Grade table. 

 
3. An Opening dialog box will appear asking to make a selection to Open the 

grade roster into Excel format or to Save to Disk  which would allow you to save 
the grade roster as an Excel file on your computer. 
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Figure 32:  Mozilla Firefox download file pop-up box. 
 

Safari – Download Grade Roster to Excel 
 

1. Begin by disabling the pop-up blocker option on your browser. On your Safari 
browser menu bar select Edit > Select the Block Pop-Up Windows option so 
that it is not checked (no check box next to the name). 
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Figure 33:  Disabling pop-up windows blocker on Safari. 

2. Back on the Grade Roster page Click ONCE on the Grid icon  located 
above the Student Grade table. 

 
3. A Downloads pop-up window will appear with an Excel file icon. You need to 

click on the icon to open the file in Excel.  
 

 
 
Figure 34:  Safari Downloads pop-up window. 
 

4. Once the Grade Roster is open in Excel, use the File menu to save the Excel file 
to your computer. 

 
 
 
 
 

Once you have completed the grade roster download process you can click on the 
Return button on the Grade Roster page to go back to the page that displays your 

Teaching Schedule. Be sure to Sign Out of your account when finished. 


